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El rey actual de los lenguajes de programacion, Java, se esta convirtiendo por méritos propios
en el imprescindible protagonista de todos los cursos, asignaturas y médulos profesionales que
versan sobre iniciacion a la programacion. Pero Java es un lenguaje orientado a objetos, y esto
supone un desafio para todos aquellos que, incluso teniendo gran experiencia en lenguajes
estructurados como Pascal o C, quieren aprenderlo o ensenarlo. Las peculiaridades de este
tipo de lenguajes han motivado la aparicion de entornos de programacion especificamente
adaptados para su ensefianza: este monografico te presenta dos de los mas utilizados ( BlueJ
y jGrasp) confrontandolos con un entorno de desarrollo profesional (NetBeans).

En muy poco tiempo aprenderas a ponerlos en funcionamiento de forma sencilla, y
conoceras sus funcionalidades mas interesantes de cara a la ensefianza y el aprendizaje de
Java. Al acabar de leer estos articulos estaras en condiciones de comenzar a trabajar y, lo mas
importante, tendras las claves para escoger el entorno de desarrollo que mas se ajuste a tus

necesidades. 1. Introduccion

Hasta hace no demasiados afos, los compiladores se utilizaban introduciendo érdenes escritas
en la linea de comandos. El proceso no era sencillo: para empezar, el programador tenia que
preparar el codigo fuente usando alguno de los rudimentarios editores de texto existentes; a
continuacién abandonaba el editor para ejecutar la llamada al compilador y obtener el codigo
compilado. Después solia ser necesario utilizar otra herramienta para el ensamblado del
programa. Finalmente, podia probar (también desde la linea de comandos) el archivo
ejecutable: pero ante cualquier error detectado, debia volver a empezar este proceso.

No es de extrafnar, por tanto, que poco a poco fuera desarrollandose el concepto de lo que se
ha terminado llamando IDE (Integrated Development Environment o entorno de desarrollo
integrado). Como su nombre indica, su objetivo es integrar en una misma aplicacién las
herramientas necesarias para realizar todo el proceso de programacion: edicion, compilacién,
revision de errores, depuracion, ejecucion.... El resultado es que utilizando un IDE, compilar y
ejecutar un programa requiere Unicamente pulsar un botén.

Existen muchisimos entornos para cada lenguaje de programacion, y cada uno de ellos ofrece
al usuario unas determinadas funcionalidades. Escoger uno u otro dependera tanto de nuestras
necesidades como de lo intuitivo y agradable que resulte trabajar en uno u otro entorno.
Normalmente el programador va probando entornos hasta que encuentra aquel con el que se
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encuentra mas comodo, pero en el caso que nos ocupa (la ensefianza de Java) nos interesa ir
sobre seguro y escoger un entorno que ofrezca al alumno sencillez de uso, facilidad para
comprender las ideas subyacentes en el proceso de programacion, y estimulacién para
animarse a hacer programas por si mismo. Cualquiera de los tres entornos que se presentan
en este monografico sera una buena eleccion de cara a la ensefianza del lenguaje.

Antes de empezar, ten en cuenta que un entorno de desarrollo no es mas que una fachada
para el proceso de compilacion y ejecucidn de un programa. Eso quiere decir que no basta con
tener un IDE instalado en el ordenador para empezar a trabajar: previamente debemos instalar
el compilador, un proceso que en Java suele generar bastante confusién.

En esta primera entrega nos centraremos precisamente en eso: la instalacién del compilador
en nuestro equipo. Ademas, se explicaran las particularidades de los lenguajes orientados a
objetos que tendremos en cuenta a la hora de escoger nuestro entorno.

2. A vueltas con las siglas: ¢ JRE 6 JDK?

Si has intentado alguna vez abordar la programacion en Java quiza te hayas desanimado antes
de empezar, y es que la instalacion de Java resulta algo compleja: veamos por qué.

Sabemos que existen lenguajes compilados y lenguajes interpretados:

- Los lenguajes compilados traducen el programa fuente a cédigo que puede ejecutar el
ordenador, y que por tanto es dependiente de la maquina en la que se va a ejecutar o, como
minimo, de su sistema operativo. Por ejemplo, si compilo mi programa en un equipo con Linux
no podré utilizar el archivo ejecutable resultante en Windows.

- Los lenguajes interpretados, por el contrario, se van traduciendo sobre la marcha, por lo
gue no se necesita compilador pero si un intérprete que también sera diferente en funcién de la
maquina en la que se instale. La interpretacion requiere tiempo: por eso la ejecucién de los
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lenguajes interpretados es mas lenta que la de sus homélogos compilados.

¢ Y qué es Java? ; Compilado o interpretado? Pues ninguna de las dos, o mejor dicho las dos a
la vez. Java compila el programa a un lenguaje intermedio predigerido llamado bytecode
(archivos con extension

class

) comun a todas las plataformas. A partir de ahi funciona como un lenguaje interpretado gracias
al entorno de ejecucion de Java, un intérprete diferente para cada plataforma y que debera
estar instalado en nuestro ordenador si queremos ejecutar programas escritos en Java. Las
continuas mejoras en esta maquina virtual realizadas por

Sun

, la empresa creadora del lenguaje, hacen que las diferencias de velocidad de ejecucion entre
Java y un lenguaje totalmente compilado (como C) sean cada vez menores.

El resultado es el exhibido por el lema de Java: compile o-nce, run anywhere. Es decir, sélo
necesitas compilar el programa una vez y podra ejecutar en multiples y diversas maquinas,
siempre que éstas tengan instalado el entorno de ejecucion.

Ahora podemos comprender mejor los dos paquetes que nos ofrece Sun para instalar Java:

- JRE (Java Runtime Environment) es el entorno de ejecucion necesario para interpretar
y ejecutar archivos .class. Es casi seguro que
cualquier ordenador que encuentres en el centro de trabajo tendra instalada una versién (a
veces varias) de este complemento.

- JDK (Java Development Kit) es el kit de desarrollo, es decir, el compilador para poder
crear programas en Java. Esta serd, por tanto, la opcidén que tendremos que escoger en
nuestro caso. Ten en cuenta que la instalacion del JDK ya incluye el entorno de ejecucion, por
tanto no tendras que hacer ninguna instalacion adicional.

Hemos dicho que los entornos de desarrollo requieren tener instalado el compilador. Por
ejemplo, si intentas ejecutar Blued sin haber instalado previamente el JDK, obtendras este
mensaje:

3/50


http://es.sun.com/

MONOGRAFICO: JAVA

Escrito por Alberto Ruiz
Viernes, 21 de Agosto de 2009 00:00

Blued could not iind any Java systems. A JDEK/J25DK must be
#'1 installed to run Bluel. If one iz installed on your system,
select "Browse™ and then browse to itz installation directory

1 Mo {suitable) Java JDKs were Found. Blued requires JDK wersion 1.5 ar later,
T Please also note, the Java Runtime Environment (JRE) is not sufficient,
You must have a J0K o run Blued,

The launcher will continue ko run - iF you have a 10K installed, wou can browse
for it {use the browser buktan),

IUnable ko locate a java executable,
Java 1.5 or higher must be installed ko run jGRASP.

If Java is installed, wou may need kto add the bin
directary of the installation ko yvour PATH
environment variable,

Acepkar
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JDK 6 Update 14 with JavaFX SDK

For your convenience, Sun has bundled Lpdate 14 of the JDK (the Java
development platfarm) and the JavaF 1.2 SDKE | which provides the
JdavaF ¥ functionality needed to develop RlAs directly. Each product
included is subject to its own license.

JDK 6 Update 14 with NetBeans 6.5.1

This distribution of the JDK includes the MNetBeans [DEE, which is a
poweerful integrated development enviranment for developing applications
n the Java platform.  * Learn more &

JDK 6 Update 13 with Java EE

This distribution of the JDK is included in the Java EE 5 S0k, which
cantains the GlassFish 2.1 application server and provides web services,
compaonent-model, management, and communications AFls for
enterprise-class SOA and Web 2.0 applications.  » Learn more

JDK 6 Update 14

This release is Windows ¥ support-ready and includes support for Internet
Explorer 8, Windows Server 2008 P2, and Windows Yista SP2. New
features include the G1 garbage collector, plus performance and security
enhancements. * Learn maore

JRE 6 Update 14

This release is Windows 7 suppor-ready and includes support for Internet
Explarer 8, Windows Server 2008 P2, and Windows “ista SP2. Mew
features include the 51 garbage collectar, plus performance and secunty
enhancements. * Learn more

JRE or JDK 6,5.0, or 1.4.2

Faster access to crtical fixes, a longer support roadmap, and enterprise
features demgned to reduce the cost nfdeplnyment Ean::h JRE ar JDK

. de 1as versiones

Latest Release | Mext Belease (Early Access) | Embedded Use | Real-Time | Previous Rele

" Readhle
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El proceso de instalacién del JDK es trivial, y no reviste ninguna dificultad. Sin embargo,
cuando empieces a trabajar es posible que te enfrentes a ciertos problemas relativos a las
distintas versiones existentes en los equipos tanto del JDK como del JRE. Este apartado te
previene para que no desesperes si te ocurren y sepas reaccionar, pero si lo deseas puedes
posponer su lectura y regresar sélo si encuentras dificultades.

Supongamos que hemos estado desarrollando un programa en el ordenador del centro de
trabajo, y nos lo llevamos a casa. Es posible que al intentar ejecutarlo en tu equipo encuentres
este criptico mensaje de error: Unsupported major.minor version. ; Cémo es posible, si en el
centro ejecutaba perfectamente? Se trata de un error muy coman, y la explicacién es la
siguiente: con un JRE moderno puedes ejecutar programas compilados con un JDK antiguo,
pero no sucede lo mismo al revés. Un JRE antiguo no sabra ejecutar programas compilados
con un JDK moderno. En nuestro caso de ejemplo, en el equipo de casa teniamos una version
de Java mas antigua, y eso ha motivado el problema. ¢La solucién? Lo ideal serd instalar en
casa la ultima versién de Java, pero existe una alternativa mas rapida: elimina los archivos
compilados (.class) del proyecto para forzar a tu equipo a recompilar las clases usando el
compilador mas antiguo.

Este problema afecta también con frecuencia a quienes prefieren trabajar a la antigua usanza,
es decir, con la linea de comandos. El caso tipico es el siguiente: tenemos instalada la ultima
version del JDK, compilamos el programa pero no conseguimos hacerlo ejecutar. El motivo es
el mismo: tratamos de ejecutar un programa con un JRE obsoleto, seguramente sin darnos
cuenta. El diagndstico es sencillo: ejecuta el comando java -version y sabras qué version del
JRE estas utilizando:

CAWINDOWS\system32\cmd.exe

C:w>java -—version

java version "1.6.68_@A3"

Java(TM> SE Runtime Environment <build 1.6.60_83-bA5>

Java HotSpot<TH>» Client UM Chuild 1.6.6_83-hB5, mixed mode?

G

Si al hacerlo ves una version antigua (por ejemplo 1.4), ya has detectado el problema. Pero
¢,comMo es posible, si instalaste la dltima version de Java? Ten en cuenta que algunas
aplicaciones (por ejemplo ciertos paquetes del gestor de bases de datos Oracle) pueden llevar
incluido un entorno de ejecucién sin que a veces seamos conscientes de ello, y por llevar
instalados mas tiempo en nuestro equipo, su ruta aparece antes en la variable de sistema
PATH. La solucion es sencilla: edita esta variable y sitla al principio del todo la ruta a nuestra
ultima version de Java.
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Volviendo a la actualizacién, seguramente estés pensando: ¢ puedo realmente actualizar el
JRE y el JDK sin perjudicar a otras personas que utilicen el mismo equipo? La respuesta,
siempre que actualicemos a versiones mas modernas, es si; pero estrictamente hablando
debemos matizar esta afirmacion. Como todos los lenguajes Java va evolucionando, y algunas
caracteristicas se convierten en obsoletas (deprecated). Es posible que, al cabo de algunas
versiones, al intentar compilar un programa muy antiguo haya alguna sentencia que con la
nueva versiéon provoque un fallo de compilacion. Sin embargo, es practicamente imposible que
eso ocurra en el nivel en que nos encontramos y ademas, incluso en ese caso, lo correcto seria
corregir las escasas lineas que dieran problemas para actualizarlas segun la sintaxis actual del
lenguaje. Asi que no temas actualizar el JDK: siempre sera una buena idea.

4. Las peculiaridades de ensenar Java

Cuando una persona aprende a programar en Pascal, Modula 2 é C, no esta simplemente
aprendiendo esos lenguajes: esta comprendiendo también el paradigma de programacién
estructurada, y por tanto sabra pasar de un lenguaje a otro con gran facilidad, tan pronto como
se acostumbre a las peculiaridades sintacticas de cada lenguaje. De igual forma, cuando
aprendemos Java debemos desentrafar el paradigma de programacion orientada a objetos,
que difiere bastante del anterior. Por tanto debemos tener en cuenta que, incluso si nuestros
alumnos tienen nociones de programacion en lenguajes estructurados - o nosotros mismos
como docentes las tenemos - sera necesario cierto esfuerzo para cambiar el enfoque sobre la
forma de disefiar y abordar nuestros programas.

Explicar las caracteristicas de Java excede el proposito de este monografico, pero es
interesante destacar algunos aspectos que afectaran a la decisiéon de qué entorno de trabajo
escoger. Y es que si en los lenguajes clasicos nos enfrentabamos a un problema pensando cé
mo

hay que resolverlo, en Java pensaremos

qué

necesitamos para resolverlo. En efecto, un programa en Java es como una obra de teatro en la
que debemos preparar primero cada personaje, definir qué caracteristicas tiene y qué va a
saber hacer: una vez ese trabajo previo esté realizado, la obra se desarrollard sacando
personajes a escena y haciéndoles interactuar.

Cuando hablamos de preparar personajes, nos referimos a programar clases. lgual que
tenemos un tipo de datos entero para representar numeros y un tipo String para representar
cadenas de texto, ¢ no seria perfecto disponer de un tipo Cuadrado, Persona, Avién, Factura,
ListaDeClientes, etc. segun las necesidades de nuestro problema? Pues eso es precisamente
lo que haremos en Java: crearemos una

clase
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Rectangulo y definiremos sus atributos (la base, la altura, el color...) y sus métodos (lo que
sabe hacer: calcular su area, dibujarse en la pantalla...). Una vez esté hecha, en mi programa
principal podré crear todos los objetos que quiera de esa clase y personalizarlos con sus
distintos atributos. Asi, las clases y los objetos son el equivalente a tipos y variables: igual que
declaro una variable entera

X

del tipo entero, creo un objeto

Jjuan

de la clase Cliente. La diferencia es que el objeto

Jjuan

no es una simple variable: incluye todos sus datos personales, y es capaz de hacer cosas
como calcular su edad - con el cédigo juan.calcularEdad()-, imprimir sus ventas -
juan.imprimirDatosVentas() -, y todo aquello para lo que le hayamos preparado.

Pero si lo que definimos son Unicamente tipos, ;donde esté el auténtico programa principal?
Debe existir un método especial, llamado main, que si nos recordara a los lenguajes
estructurados; s6lo que en este caso su misién consistird Unicamente en crear objetos a
imagen de la clase (sacarlos a escena) y pedirles que hagan cosas. Es aconsejable incluir este
método especial en una clase aparte con un nombre significativo como

Test

0

Principal

, para que el alumno entienda que esa clase no representa ningun concepto (una figura, una
persona) sino que simplemente alberga el método principal.

Una de las grandes ventajas de Java es que las empresas pueden repartir el trabajo de
programacién, encargando el desarrollo de diferentes clases a diferentes personas. La
integracion del trabajo es sencilla dado que las clases son cajas negras: solo necesitas saber
qué atributos tiene la clase Cuadrado y qué métodos posee. Pero por complicado que fuese
para quien lo programd, no necesitas saber como resolvio el método

calcularArea

de una figura: te basta con saber que esta disponible.

&Y en qué afecta todo esto a nuestra labor docente y al entorno? Veamos algunas
conclusiones interesantes:

- Lafase previa a la programacion en Java es muy creativa: se trata de disefar las clases
gue voy a necesitar, y modelarlas segun el problema que quiero resolver. ;Qué es para mi un
cuadrado? Si mi problema es trigonométrico,su atributo sera el lado. Pero en otros contextos
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quiza necesite conocer el material de que esta hecho, o su color. Algo parecido pasa con los
métodos. ¢ Qué voy a querer pedirle a un cuadrado? Quizé que calcule su area, o quiza que se
dibuje en la pantalla.

- Las clases estan pensadas para ser reutilizadas por otras personas distintas a aquella
gue la programo. Para ello es fundamental documentar nuestro trabajo: el programador, de un
vistazo, debe poder saber qué atributos tiene la clase y de qué métodos dispone. Existen dos
herramientas basicas para esta mision: la documentacion JavaDoc (una pagina web
estandar en la que se resume todo el contenido de la clase, cuyo uso no sera cubierto en este
articulo) y los diagramas de clases, que muestran para cada clase sus atributos, sus métodos y
su relacion con otras clases. Dichos diagramas pueden tener este aspecto:

Obra > — Artista
private String titulo; private String nombre;
private Artista autor; private int afioNacimiento;

private int afioEdicion;

Artista(String, int)
int getARoNacimiento()
void setAfioNacimiento(int)
String getNombre()

void setNombre(String)

String getTitulo()

void setTitulo(String)
Artista getAutor()

void setAutor(Artista)
int getAnioEdicion()
void setAfoEdicion(int)

Libro Disco Pelicula

private String editorial, private String discografica; private Stnng productora;
private int nPaginas, private int nCanciones, private Artista[] interpretes,
Libro(String, Artista, int, Disco(String, Artista, int, Pelicula(Sining, Artista, int,

String, int) String, int) String, Artistal])
String getEditorial() String getDiscografica() Artista[] getinterpretes()
void setEditorial(String) void setDiscografica(String) void setinterpretes(Artistaf])
int getNPaginas() int getNCanciones() String getProductora()
void setNPaginas(int) void setNCanciones(int) void setProductora(String)
void impnmir() void impnmir() void impnmir()

Por tanto, conviene habituar al alumno a comenzar su trabajo disefiando las clases sobre el
papel utilizando este tipo de disefios. Sera interesante que el entorno sea capaz de crear por si
mismo diagramas a partir del cédigo introducido, para que el alumno pueda contrastar su idea
original con la clase que realmente esta programando. Una buena préactica consistira en que un
alumno trate de utilizar una clase programada por otro compafero, disponiendo Unicamente del
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diagrama de clases. Pero sigamos con las conclusiones:

- Frente a los lenguajes estructurados, el programa mas sencillo que utilicemos en Java
tendra seguramente un minimo de tres o cuatro clases, lo cudl requiere que tengamos abiertas
un buen numero de ventanas a la vez. El entorno de desarrollo debe estar capacitado para
permitir manejar cdmodamente multiples archivos abiertos.

- Java no es un lenguaje para los impacientes. Para resolver un problema sobre
trigonometria debo pasar un tiempo disefiando y programando previamente las clases
correspondientes a las figuras; pero hemos dicho que una clase es como un tipo de datos, y
por si misma no hace nada, no puede ejecutarse. Sera al final, cuando ya tenga todas las
clases listas, cuando escriba un programa principal que creara distintos objetos a imagen y
semejanza de sus correspondientes clases, y esos objetos si que haran cosas. Para evitar el
desconcierto o aburrimiento del alumno ante esta situacion, algunos entornos ofrecen una
posibilidad didacticamente interesante: una vez programada la clase Cuadrado, puedo crear
graficamente un objeto miCuadrado e interactuar con él, probando asi sus métodos y
observando sus atributos, y todo esto a golpe de ratdn, sin necesidad de escribir ningun
programa principal.

5. Escogiendo un entorno de desarrollo

Ya estamos listos para empezar: con el JDK instalado, y teniendo en mente los aspectos que
debemos destacar en la ensefianza de Java, pasaremos a analizar tres entornos de desarrollo
en sendas entregas de este monogréfico. Para cada uno de ellos encontraras las siguientes
secciones:

- Puesta a punto: se trata de una guia rapida que te permitird ponerte a trabajar en pocos
minutos y compilar tu primer programa de prueba.

- Sacandole partido: incide en las funcionalidades mas interesantes que te ofrece la
aplicacion.

- Valoracion: repaso esquematico por las ventajas e inconvenientes que presenta el
entorno frente a las otras opciones, siempre desde el punto de vista de la docencia.

Un altimo apunte: aunque los tres entornos estudiados tienen versiones para Linux, las
explicaciones se han hecho sobre la versién de Windows, por ser el sistema operativo mas
frecuentemente encontrado a dia de hoy en los centros educativos.
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Entorno de desarrollo jGrasp

jGrasp es un entorno de programacion ligero surgido en el @mbito universitario, concretamente
en la universidad de Auburn. Te permitira trabajar con distintos lenguajes de programacion,
aunque l6gicamente en el contexto de este monografico nos centraremos en sus posibilidades
de cara al lenguaje Java.

jGRASP

Copyright 1999-2009 Auburn University
Computer Science and Software Engineering
Created by James H Cross 1 & Larry Barowski Vv 1 E 5_1 5

1. Puesta a punto

Lo primero que haremos sera acudir a su pagina web y descargar la ultima versién disponible.
La instalacion es sencilla y no se nos preguntara nada durante el proceso; por otra parte, si
instalaste el JDK previamente como hemos sugerido, jGrasp lo detectard automaticamente y no
tendras que configurarlo. En cualquier caso y si tuvieras varias versiones de JDK conviviendo
en el equipo, siempre puedes acceder a la opcidén Settings > Compiler Settings para cerciorarte
de qué JDK estas utilizando. Es el momento de arrancar el programa:
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A jGrasp

File Edit Wiew Project Seftings Tools Window Help

| Java

| CIMi masica

| 9 Mis archivos recibidos
| O] Mis imagenes

|3 TomTom

Explorador de archivos

Depuracion Banco de objetos
-

Browse | Find | Debug | Workbench |
—

=
i
[ ]
g
-
3
L4

Area de trabajo

Compile Messages | jGRASP Messages | Run II'IZIL

sor_| '\

\

| Claar T Resultado de ejecutar nuestros programas
Cooy. | \ Mensajes de errores de compilacidn

[4]

13/50



MONOGRAFICO: JAVA

Escrito por Alberto Ruiz
Viernes, 21 de Agosto de 2009 00:00

A jGRasP

File Edit Wiew Project Setings Tools Window Help

Al Files |#) | sort By Name =)
= Hmena,
= D

A Docs

[CJimagen de Recuperacidn
OJava

L3 Ml madsica

O Mis zrchivas recibidos
A Mis imagenes

A TomTom

L]
L3

—[ Erowse J Find l Debug l ‘Workiench J

_[ Compile Messages | JGRASP Messages | Run 0 l
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(A File: Persona.java E:\JavallGrasp - jGRASP CSD (Java)

Eile

Edit View Build Project Seftings Tools Window Help

BB ABBRe RED "' WE2Y +X86000E
T 4
All Files I"”ﬁMB',I'NImE |v| sl public class Perso
] l
@ £ % Ex|&a, private String dni;
I private S5tring nombre;

E:" |"'| private int afo nacimien Depurar
CDocs
Dlnamnﬂeﬂmupﬂramm public Scring getDni ()

L Ejecutar
;EJJ?UH__ return dni; ’ '
| T Mi miisica } Compilar
3 Mis archivos recibidos
| L] Mis imagenes public void secDnl{Scring nusvoDni)

[

TomTam

= chi=.dnl = nusvoDi:

1

Pestanas para manejar multiples archivos abiertos

== L - ' .
Browse | Find | Debug | Workbench | (§] personay..
- ; ; ;

Compile Messages | jGRASP Messages | Fun 1O |

| Stop
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[ File: Persona.java E:\Javal\JGrasp - jGRASP CSD (Java)

File Edit View Build Project Seftings Tools Window Help

adEé ¥nil«e BED

I 200005

All Files |v |T'!'.-:||1 By Name —|v| ¥ Ll public class Perscna
" 210
<= @ a | .,. | private String dni:
- - 4 private Jtring nombre:
\ |'| 5 private int nﬁn_nm;imi':nr.u;
ClDocs [
Climagen de Recuperacion ; i"-ﬂ‘ll':' String geclni()
a g ceturn dni;
Ej““ﬂﬂﬂﬂa 10 1
CIMis archives recibidos 11
Euls Imagenes 12 pulalic vold secDni(Steing nusvoDni)
13 {
TemTom
Ij 14 chis.dni = nusvoDi:
15 1
1€
17 1
1B
19
Z0
Conviene mostrar los nimeros de linea
e o O B e e L ara localizar facilmente los errores
Open Projects P
| 1 Il ] ,
Browse | Find _Debug | Workbench ] Persona,j..

o

“Compile Messages | JGRASP Messages | Run10 |

-

- ————3GRASP exec: javac -g E:lJavalJGrasp) Peraona.java

| Stop
-
»| Persona.d cannct find symbol
Clear ﬂmﬂl HE i - aidle nusvoDi

location: class Fersona

this.dni =

1l eEEOE

nue'.rcn:\

g

Ajusta el tamano de
cada ventana
segun lo necesites

Linea en la gue se
encuentra el error

Descripcion del problema

'\ Localicacidn precisa del error

————3GRASP wedgel: exit code for processa is L.
L ----3jGRASP: operation complece.

4 ]

Line:14  Cok1  Coded

Top
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(M File: Test.java E:\JavallGrasp - jJGRASP CSD [Java)

File Edit View Build Project Sefiings Tools Window Help

AHEE ABDRe RLOD ' Int¥Y +X800HE

|MFIm: |v Sort By Name - p ublic class Test
- [
{}] g 20 s o public static void main (Scring [] acgs]|
- {
E:l .. System.out.peincln( "OBSEEVATORT MICE™) ;
CDhocs (= !
] imagen de Recuperacion = }
[ Java —
T = |
Open Projects
4 |

Browse | Find | Debug | Workbench | ' |iEPmarra.i.-I (8] Testjava
{:mlehlessanes | iﬁRASPHessaues | Run b0 |

Encl

-——=jGRASF exec: java Test

Clear OBSERVATORIO CNICE
—

Help \\xx -———3GRASF: operation complete.

-
Limpia la ventana inferior
[ | |
B E 5 . . . . . , .. Line3  Cok42 Code:d  Top:d
Uldl BT UOGCLOCLD! ICUIGIN 0 VAN ZI i icions C vl O

\J calud VY ULlalUud U " CA U CA Ul A

. Sacandole partido

Hemos dicho que los programas en Java estan normalmente constituidos por varias clases. Por
ello, todos los entornos de desarrollo permiten crear proyectos para tener rapido acceso a
todas las clases que van a participar en nuestro programa. jGrasp no es una excepcioén, asi

que vamos a ver como podemos dar forma a un sencillo proyecto Java. Para empezar, accede
al menu Project > New > New Standard Project:
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[d New Project
E:UavaUGrasp

Buscar en: |[]JGrasp

G

=1t
Defauk Extension:
Aap) |

Add Files M:D
e
[ | Open UML Window

Filter Extensions:

Mombre de archivo: trignnnmetria|

Archivos de tipo: IGRASP Projects (*.apj)

18/50




MONOGRAFICO: JAVA

Escrito por Alberto Ruiz
Viernes, 21 de Agosto de 2009 00:00

[# Project: <trigonometria= File: Test.java [P] E:\Javalfiguras - jGRASP CSD |Java)

File Edit View Builkd Project Settings Tools Window Help

OHES ARBEae DOD'In&Y X80

:
L)
|J!|l Files |v||§nﬂﬂyllame |v| ¥l rackage figuras;
I(:: =]l =1 public class Teat
i
E |'| public static volid main (String[] acgs)
A bocs {
n" agen de Recuperacion System. odt . princln ["Vamos a calcular &1 area de la figura propussta.™);
DJM. f Cuadrado cual=n=v Cuadrado(4.2);
ﬂ“ Musica cual. impeimiz ()2
L3 Mis archbeos recitddos
T3 Mis imdgenes Circunferencia cirl=nev Circunferencia(4.8):
DTDI'I'IT'DI'I'I CArl. imprimic{h:
cirl. imprimiz3 ()
Circunterencia clel=nsw Clrcunferencia (1.5):
CArZ. lmprimir ()
- CArl.imprimirz () ;
Open Projects
f - Triangulo tril=new Triangulo (3, L5):
B =UML= cril. impeimiz () ;
ﬁ Circunferanciajava  _Migurast System.out . princln["Para calcular el arsa de la figura debemos rescar al
ﬁ Cuadrado java | Migurasi System.out.prineln("ELl Area de la figura complera 25 " +(eril.caleularidre
8l Testiava . Mguras
ﬂ Trisnpulojava  Wguras double perimetroTotal=tril.calcularPerimetro() +ocual.calcularPerimetea (i—(
System.out.prineln("El perimstro de la figura complets es ™ + perimetroTo
Archivos pertenecientes al proyecto | - 1
4 |
Browse | Find | Debug | Workbench (8] cncunter... | [§] cuadrado.. | [§] Testjva | [E] rrianguio...
.

l| Compile Messages. | JGRASP Messages | Fun O |

End ====71GRASF exec: Jjava figuras.Teat

1 Vamos a calcular el drea de la figura propussta.
Clear El lado del cuadrado =s:d4.2 ¥ su area =3 17.84

El radio de la clrcunferencia =3 4.8 y 8u area =8 72.38229473870884
Help la micad de su Area =8 36.19L14736935442

El radio de la clrcunferencia es 1.5 ¥y 8u area =g 7.0885834705770345
CEE8S Cuarcos de su area &8 5.301493760293Z2776
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[ Project: =trigonometria=

File Edit View Build Project Settings Tools Window Help

SaHESe &0 28000 E

File: LML (Java) for Project: trigonometria E:\Java\JGrasp

Cuadradojava . figurasi
Testjava Mgurast
Trangulo java . Mguras

4
| Files | w | Sort By Name | - |le Scale: 1.0
e, ialialil
) =] [=
[Docs —
Climagen de Recuperacion
CdJava =
CImi masica Cdm‘ Cuadrados
[ Mis archivos recibidos | | -
M Mie imdnanas = :
- |
m '
Open Projects Test
7 T Circunfarencia Cuadrado Trianguls
] . trigong a F\lavalJGrasp B iy figuras  [----»
x figuras figuras tmain) figuras.
(4] [TEFEncia java Rouras)
ColeccionCuadrados java 0 Docsialtutorias B R k. o i s ettt e

i 1l | [ ]
1] [n]
Browse | Goto
| Debug . UMLInfo | Workbench |@CIWHH--|WHW#-.I [&] Testjava I@Imnmm--] (] =trigono...
a“w
Compile Messages | jGRASP Messages | Runlio |
Stop {
] ====JGRASP: operation c lece.
Clear d P R
! ==== GRASPF exec: javac =g E:'Docs)al tutorias'codigo figuras’ ColeccionCuadrados. jana
[
-———3YGRASP: operation complsce.
! 1l

Classes | Inter
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[A Project: <trigenometria=  File: UML [Java) for Project: trigonometria E:\JavallGrasp

File Edit \View Build Project Settings Tools Window Help

SdEde & 186000

Project: trigonometria E:\Java MGrasp |'r

ﬁgurmmr:uﬂammla

FIELDS: Atributos de la clase
[, radio: private double radio
CONSTRUCTORS:

[ figuras.Circunierencia(i: public figuras.Circunferencia(double)| |

METHODS: Métodos de la clase

E calcular3Cuartofreal): public double calcular 3ICuartofreal)
[ calcularAreai): public double calcularireal)

i calcularMiadAreall; public double calcularMitadAreal)

E calcularPerimetrofi: public double calcularPerimetrof)

[ aetRadion: public double getRadiof)

[ imprimirij: pubiic void imprimir()

[ imprimir 2} public void imprimin2()

I irprimin 305 pubiic vabd ingrimin 3

[ setiadiogy: public void setRadiojdouble)

L]
ColeccionCuadrados
figuras
W
Test
Circunferancia | . Cuadrado | . Trianguko
figuras <"1 fgwas |- fgwas -3 g
{main}
:l Prpacl Chms  —-——— 3 (har | reles nos ., &G |
Seleccionamos una clase para ver su diagra
U m |

| Browse | Golo | Debug | UMLInfo | Workbench

-

Compile Messages | JGRASP Messages | Raum 10

' ;@WHEWMIEEIMHM I [&] <trigono... |

ot p

| clear ||

ne=j=w . . ‘ .. - .

Gl Ut ey e e ey e e L et Uy md [T T ETR IR Chs
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E Pr !'rjl'!'l'1 = iE;l'l et ria e
Fidle Edit View Build Project

File: Colecciond ||.=u||:|t14'u'..ja'n.r.=| - [F—‘] E:\WDocs\al\tutoriashcd "”E-"' 'Lfi;:_-,||r.'-|.~'.
Seftings  Tools  Window

SEES Xb B e

JGRASP CSD (Java)

Help

DT ey 280600 HE

i
{
| Files 'r||5|u|1 By Name |vI % ir.-uj.'-l ic hoolean afadirCuadrado (Cuadrado cuadradoSolicitado)
E‘E g D ' — for {int i=0; i<cuadrados.size(): i++)
i

v 1
EX |'| = Cuadrads ¢ = cuadeados.gec (i) :

Clnocs Lf je.getLada () == cuadradoSolicitade.getladai))
Climagen de Recupetacion i : y p

=T Syatem.out.println(“No podemos afadir el cuadrado,

& -+ reruen Talss;

CIMi musica Dy

CAMis archigs recibidos )

DH|5|MEM 21 llegamos a Sg9Ce punc I tor ha acabad OF T

sclicitads no ==staba s =n =] Arraylist uads &c dhara
TamTarm ! :
Ij — cuadrados, add |cuadradoSolicicade) ;
#—— return truse;
L¥
A R public woid imprimir ()
Open Projects
¢ (8 wigonometria E\JavalGrasp — System.out.println(™Imprimisnd 3 cuacdradea de la
& LML=

ﬂ Circunferencia java  Migurash

{3l ColecclonCuadrados java L \Docswaiutorias

for (int i=0; i<cuvadrados.gizei): 14++])

ﬂl‘luadrad:.ia'.ra Migurast
(@ Testiava tigurasi
(8 Triangula java figuras g rublic boslzan borrarCuadrade (double ladoSolicitads)
. — "
4] I | [® |41 I
| Browse | Fina | Debug | workbench |[%] coteccion... | [] circuntes...

Compile Messages | |GRASP Messages | Run 10 |

| Slop
Clear i
CEMS . Y a g Cu o , - — e . .. LinES50 Cok1
[y I L N N IERN GERatl R | ! 3L

os s ey as o v o lelele
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E Project: <trigonomeiria»  File: Triangulo. java [P] E:\Java\liguras - jGRASP CSD {Java)
Eile Edit View Bulld Project Seflings Jools Window Help

eSO XK2Ba RPED 'hA2Y $1X86

9 . milCuadrado id = 350 Aguras Cuadrado ,‘ packags figuras;:
s taco= 230 private double : figuras Cuadradn
? . unaCircunferencia id = 358 - figuras Circunferenciz public class Triangulo

i
private double bame;
prlvate double altura;

h radio = 99,0 : private double © figuras, Circunfere

publis Trlanguls (double base) doubles alLuea)
[

this. bass=hase; : '
Podemos hacer pruebas [A Create Mew figuras, Triangule
invacando metodes de
estos objetos IE figuras. Triangulo
Workbench Name
1 [rimriangula |
this.H [ public Trianguioidouble base, double altura)
}
public dd
Cl I ] Iv] ’
Evaluate Expression - i retucpl
| =] [Lee ] | frar
‘Browse | Debug | Find | Workbench | |[E|Eimum-].3 pleccion...
".‘.’. e S | R =init=() dectared in Tguras. Triangulo o
Compile Messages mspmmu | Run 10 e i
Stop | doulde hage
| 45 1]
Clear
douldle altura
_cony | o =]
il H | create || Show Doc || Close |

Codel  To
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[A Project: <trigonometria=  File: Test.java [P] E:\Java\figuras - jJGRASP CSD (Java)
File Edit View Builld Project Settings Tools Window Help

SHES K2R e @[m I & Q0 4 OB

o cirl.impr imiz (M7 : -
(4} L J I& m > g > X e STET Impr ISIET 117 Control de la ejecucion
Threads Circunferencia cirl=newv Circunferencia {(1.5):

clrZ .1:rupr Imie ()5
Call Stack cirl.imprimizrl () :

Triangule tril=nev Triangulc (8,15):
Tril.imprimie() ;

Syatem.out.println("Para calcular =1 area de la figura debemos restar a
Syscem.out.princln("El Area de= la figura complecta =3 ™ +(cril.calcularh

o= [] static © (iguras Tash

- D;\.--Lument_- doub 1e ]‘.‘-l’:ILl‘ﬂ-"‘EEDTDIdl—EL’ll l':aLliLllEI.I:’PEILm:I'_EDII+E1Jﬂ.J. Eﬂll’."'lJ].c'L[F“Ei]‘ul’:'EIClll
0 5 = = =

o [ arusi] - id = 51 - java.lang Stingl] *‘ ........ System.out.princln("El perimetro de L completa 3 " + perimetro
¢ [JLocals System.out.println("El pecimetro d + tril.calcularPer
¢ I cuat id= 52 Aguras Cuadrado | }
P ado= 4.2 private double © fguras Cua 1 L
9 . cirl id =53 figuras Circunferencia
fee radio = 4.8 private double : figuras. Cir \ El programa se ha detenido en el punto de ruptura
¢ [l cir2 id = 54 - figuras Circunfarencia - " creado por el usuario
fm radio= 1.5 private double : figurag Cir H-‘_\-—\_\_ : ) f
o [ kit id = 55 ; figuras Triangulo - T Podemos examinar los valores de variables y objetos en este momer
[ k|
1] ]
[ Browse | Debug | Find | Workbench [& cwunter... | [&] cuaarad... | .e_ﬂq_ | (& rrianguo...

| Compile Messages JGRASP Messages EHHI'II:’O‘ |

E“d El radio de la circunferencia &8 4.8 y 8u area &8 72.382289473E70334
la mitad d= su Are=a &5 3E6.1911473£935442

El radio de la circunferencia =3 1.5 y su area es3 7.0685834705770345

EEES cuaArtos de su Area =8 5.301437E0Z93Z7T7E

La base del ctriangulo es 8.0, su altura es 8.0 El area del criangulo es £0.0

Help Para calecular el Aresa de la figura debhemos restcar al Aresa del triangulo, la mitad del area del ciel y un
% El area de la figura completa es 119.132584572128719

Clear

A continuacién se indican los aspectos que sobresalen en jGrasp, para bien o para mal,
respecto al resto de entornos estudiados:

Puntos fuertes de jGrasp
- Su planteamiento y organizacién es similar al de IDEs como NetBeans o Eclipse,
acostumbrando al alumno a entornos mas profesionales
- Permite una comoda organizacién cuando hay muchos archivos abiertos
- Genera automaticamente diagramas de clases UML, de gran utilidad didactica

Puntos débiles de jGrasp

- Su aspecto no es demasiado atractivo
- La gestién de los paquetes podria ser mas clara

24 /50



MONOGRAFICO: JAVA

Escrito por Alberto Ruiz
Viernes, 21 de Agosto de 2009 00:00

- Carece de documentacion en espariol

Entorno de desarrollio Blued

Blued es un sencillo entorno de programacion exclusivamente disefiado para la ensefianza y el
aprendizaje de Java. Se trata de un proyecto nacido en el seno de un grupo de investigacién
universitario integrado por miembros britanicos y australianos. Por sus novedosas
caracteristicas, en poco tiempo Blued alcanz6 una gran popularidad en entornos docentes.

University of

ent

Blue)

DEAKIN UNIVERSITY

S
Version 2.5.1 2 Sun

microsystems

1. Puesta a punto

Lo primero que haremos sera descargar el programa de su pagina web y proceder a instalarlo.
El procedimiento es trivial y, asumiendo que ya tuvieses instalado el JDK, no tendras que
configurar absolutamente nada para empezar a trabajar; pero antes de programar nuestra
primera clase, debemos hacer una aclaracion previa.

La pantalla principal aparecera en gris hasta que creemos un proyecto. En BlueJ existe una
desafortunada confusién entre el término proyecto, tal y como suele entenderse en los IDEs, y
el concepto de paquete, antes explicado. Asi, un proyecto Blued es igual que un paquete, pero
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en aras de simplificar se eliminan las lineas de cddigo package, obligatorias segun la norma de
Java. Si trabajar con paquetes es prioritario para ti, Blued no es definitivamente la mejor opcién.
¢, Significa esto que no podemos utilizar en Blued paquetes de clases programados en otros
entornos? Existe una forma de incluirlos en nuestro proyecto, Project > Open non Blued, pero
sin duda no resulta nada intuitivo.

No nos quedemos con este defecto, sin duda uno de los pocos que presenta el entorno:
creemos un nuevo proyecto con Project > New Project y ya podremos empezar a trabajar. La
pantalla se mostrara asi:

Bll.IEJ: trigonometria | -
Project Edit Tools Wiew Help

Mew Class...

izompile

il

Area de archivos del proyecto

Barra indicadora de ejecucion de programa

it

e

Area del banco de objetos

26 /50



MONOGRAFICO: JAVA

Escrito por Alberto Ruiz
Viernes, 21 de Agosto de 2009 00:00

Como ves, la pantalla principal es tremendamente sencilla. A la izquierda tenemos los botones
de nueva clase y compilar; a la derecha la ventana principal, en la que veremos el esquema de
clases. Abajo esta el banco de objetos, similar al de jGrasp, que se estudiara mas adelante. Por
ultimo, una barra gris cambiara de color y se pondra en movimiento cuando haya un programa
en ejecucion.

Existen dos formas de anadir una clase al proyecto: la primera es crearla nosotros mismos,
mediante el botdon New Class. La segunda es afadir una clase existente, mediante el menu
Edit > Add class from file. Ten en cuenta que esta clase se copiara al directorio del proyecto
actual, mientras que en jGrasp esto no ocurria: simplemente se utilizaba la clase desde su
ubicacion original. Por otra parte no hace falta que te preocupes de guardar las clases, ya que
Blued lo hara por ti cada vez que compiles o cuando cierres el programa.

El entorno incluye un sencillo asistente para crear clases, cuya mision es proporcionarte un
modelo o esqueleto de cédigo sobre el que trabajar. Este borrador sera distinto si queremos
hacer una clase estandar o, por ejemplo, un applet (aplicacion grafica de ventana). Sin
embargo, y ya que la mision es aprender, quiza sea mejor borrar la propuesta y comenzar a
trabajar con el editor en blanco.
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Ed BlueJ: trigonometria
Projeck  Edit  Tools  View Help

Mew Class... Test

— m

—>

Compile

[nitialising virtual machine... Done.
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BlueJ: trigonometria

Projeck  Edit  Tools  ‘iew Help

Mewe Class.. Test

Compile

il

Test
Class  Edit  Tools  Opions

LIndo [Cut][CDp@.r][F‘aste”Find...”Find NERTHClDSEI Source Code

public class Test
{
= public ztatic woid main (3tring [] args)
{

Systen. out.println(TOESERVATORIO CHNICE™) :

B BlueJ: Terminal Window - trigonometria |._||E £|
Options

OBSERVATORIO CNICE

saved

SencillC; v-'or:o Veamos o
5 Sadan ole partido

Retomemos un proyecto completo, que involucre distintas clases:
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Ed BlueJ: trigonometria
Projeck  Edit  Tools  View Help

Mew Class..

——->

—>

Circunferencia

Compile

Triangulo

ColeccionCuadrados

Cuadrado
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ki Circunferencia

Class Edit  Tools Options

SEE

Compile | [Unda | | cut| [Capy | [Paste | | Find...| [ Find Next| | close |

Source Code w

public clasz Circunferencia

{

priwate double radio;

public Circunferencia (double radio)

P

Y

,, I

cannok find symbal - wariable radi

i You are using a symbol here (a name For a variak
this.radio=radio; a method, or a class) that has not been declared
} any visible scope, Check the spelling of that nam
did you miskype it? O did you Forget to declare it
public double getRadioi) Cr mavbe you did declare it, but it is not visible
{ From here,
return radi:
) Acepkar
public woid setRadio(double radio] W .
{
thiz.radio=radio;
'
public double calcularbreal)
{
“
s daaaran s la A E s Als I~ TIT & —
£ >
t find bol - wariable radi
cannat find symbal - variable radi k E B#ﬂ"lﬂ!'d
otk i x x S50 n el G s
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BIUEJ: trigonometria r;
Project  Edit  Tools Miew Help

|New Class.. | Test

> |

. — | : : .
Circunferencia |

| Compile | -E‘.AI

Triangulo ™

Qpen Editor
Cormpile

Inspect
BluelJ: Create Object

Femaove

Triangulo{double hase, double altura)

Mame of Inskance: |kriangull

niew Triangulo ( 54 , double base

39 :l double alkura

Afa
oNC

SOUTSaEOre pladesosr a|asieclo del banco de tranajo en la parte inferior de la pantalla,
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B|UEJ: trigonometria
Project  Edit  Tools  Miew Help

MHew Class...

——-»

Circunferencia

Campile

Triangulo

Cuadrado

ColeccionCuadrados

miTriangulal: cuadradal: micircula;

Triangulo Cuadrado Circunferencia

riCircula : Circunferencia
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BlueJ: Method Result

B3 BlueJ: trigonometria

double calcular&real)
Project  Edit  Tools  Wiew Help

riCirculo. calcularareal) rerect
double | 3421,194399759285|
n
Circunferencia 1
<
I
| /
Triangulo i
< inherited from Ohject Iﬁ'
double calcular3Cuantofraald
Cuadrado A
double calcularAreal
double calcularmMitacdareal k
double calcularPerimetrof
double getRadio)

void imparimir()

miTriangulol; cuadradol; miCirculo; W?d ?mprfm?rm
Triangulo Zuadrado void Imprmir3g
vaid setRadioddouhle radio

micCirculo ; Circunferencia Inapact

Removie

BlueJ: Object Inspector Z| |E fgl

kriangull @ Triangulo

private double base

private double albura

Shaw skatic Fields
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BlueJ: trigonometria

Project  Edit Tools  Wiew Help
Circunferencia ! !
<
|
|
Triangulo I
*E—J
ColeccionCuadrados
Cuadrado
=——- -
o o ai e s J
Code Pad
-
T < cuadradol calculardreanl S
miTriangulol: cuadradol: 20250 (dauble)
Triangulo Cuadrado ~ Math.max(35,36
36 {int)
< dAF-45+(300-2)
09 {inf

| 3
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BluelJ: trigonometria

Project  Edit  Tools MWiew Help
|New Class... | Tant
[ = ] = . new Testh
=
Circunferencia
| Compile | €
Cpen Editar
Triangulo Compile
< Inspect e
Bl uadrados
|
Cuadrado _E:___}
g S PR JI
—————
B W .
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n
1
1i
12
14
15
16
17
i
11
in
j §
i
iz
ig
iS5
43
£
ot
i3
n

lass Tools  Options
’Cnmpile] ’Undn] ’Cut] [Cnpy] [F‘aste] ’Find...] ’Find Ne;d] ’ClDSEI Source Caode w
k] M

Cuadrado cual=new Cuadrado(d.2):
cual.imprimiri():

Circunferencia cirl=new Circunferencia(4.8):
cirl.imprimiri():

cirl.imprimir3i() ;

Circunferencia cirZ=new Circunferencia (1.51;
cirZ.imprimiri():

cirZ.imprimira(); Puntos de ruptura
(breakpoints)

Trianculo tril=new Tri
tril.imprimi B

Jystenm calcular el area de la figqura debemoz restar al area del

Jystem. out.print

.out.printlni(™F
'El Area de la figura completa &3 " +(tril.calcularlrea|)+cirl

douhble rimetroTotal=tril.calcularPerimetraf)l+cual.calcularPerimetro()-(cual. get

.out.println("El perimetro de la figura completa ez " + perimetroTotal):

dyatem. out.println(“El perimetro del tridnoqulo es " + tril.calcularPerimetrof)];
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Zlass Edit

Toals

Options

| compile| [Unda | | cut| [copy| | Paste | [Find...| [ Find Next| [ close |

Source Code

1
1n
11
1
12
14
15
16
17
1
11
in
£l

=
iz
id
5
6
7

@
id i
|}

4

Cuadrado cual=new Cuadrado(d.2):
cual.imprimie() ;

BlueJ: Object Inspector

Circunferencig
cirl. imprimidf . FETTER R AT
cirl.imprimin S

Circunferenci

cirl=tnem Cirmmmferencialidd

i Cuadrado

private double lado

cirZd.imprimiy |Threads

L Wmain &k breakpoint)

Clrsd.imprimin

Triangulo tri
Cril.imprimin

Show static Fields ]

Inspect

ek

| Close

Aystem. out. py |Call Sequence
Jystem. out, pH
double perime
Aystem. out, pH
Jystem. out, pH

Thread "main" stopped at breakpy

Skatic wariables

Instance wariables

ocal variables

Circunferencia cirl = =object reference =
Circunferencia cire = <object reference=

=

Step

Halt

Triangulo tril = <object reference =

I
¥
Terminake

Step Into Cankinue

rea deli=
[1+cirl

ual. get
al):;

rafll:

|

:I savad

Destaquemos para terminar los puntos fuertes y débiles de este entorno:

Puntos fuertes de Blued

- Su sencillez y facilidad de manejo resultan simplemente inigualables

- Sus funciones de creacién visual de objetos estan integradas de forma facil e intuitiva
para el usuario

- Existe documentacion oficial en castellano
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Puntos débiles de BluedJ

- Se oculta al alumno la gestién de paquetes

- Las ventanas independientes resultan algo cadticas cuando se manejan muchos archivos
alavez

- Los diagramas de clases no aportan ninguna informacion sobre las mismas, resultando
de escasa utilidad

Entorno de desarrollo NetBeans

Existen varios entornos que han encontrado aceptacion por profesionales y aficionados. Los
mas conocidos son probablemente Eclipse, NetBeans y IntelliJ IDEA . Los dos primeros
resultan mas interesantes por ser de cddigo abierto, y para este articulo se ha escogido
NetBeans por presentar una ventaja adicional: al ser desarrollado por la compania Sun, la
misma que cred Java, puede descargarse e instalarse en un mismo paquete con el kit de
desarrollo JDK, lo cual simplificara su instalacion a los alumnos.

& NetBeans

e ——

1. Puesta a punto

Al igual que con los otros entornos estudiados, la instalacién de NetBeans no presenta ninguna
complicacion, incluso si se escoge descargarlo por separado desde la web del programa . Sin
embargo, al abrir NetBeans nos encontramos una pantalla algo mas confusa que en los
anteriores entornos:
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W NetBeans IDE 6.5.1

« x] ¢ || StartPage x

File Edit Wiew MNavigate Source FRefactor FRun Debug  Profile

DS "

Versioning  Toaols  window  Help

[ = e
[
Lo
iﬂ
4
L
4

Quick Start Tutorial

What's New

Take a Tour

add anw IDE plugins that vwou have not wet
installed and look for other Features provided
by the MetBeans team and other developers,

Add Plugins >>

Welcome to MetBeans IDE

Java

General Java Programming
Java Web Apps

Ruby and Rails

S0A

PHP Apps

Shaow Cin Skarkup

HetBeans Modules

Swing GUls
Java EE
Mobile Apps
UML Modeling

More Demos and Tutor
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W New Project

Steps Choose Project

1. Choose Project Isit.ggﬂﬂa'_____._ Projects:
20 \_@_Jav_a___‘) J‘Jaa fpplication
e ——

- ----- ) MetBeans Modules 5 Java

&7 Samples (59 Java Class Library
@ Jawva Projeck with Existing Sources

A% Java Free-Form Project

Description:

Creates a new Java SE application in a standard IDE project, ¥ou can also -
genetrate a main class in the project, Standard projects use an IDE-generated 5
ant build script to build, run, and debug vour project, 3
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W triponometria - NetBeans IDE 6.5.1

FI|E Edit Wiz Nawgate SOUrce Refactn:ur Fun Debug Profile  Yersioning  Toals  wWindow  Help
E % |_|. .,|_| |~=:u:|eFauIt config:= vl ? % |> - @ - |Qv (Ckrl+I)
4l ch]:Flles | Services { | Start Page x @.E’ Main, java xD [«
EI@ trigonometria -H- |9 %\EW | &8 R i | @ B | @ _s
E& [E Source Packages — —
I:EI trlgunnmetrla
* To change thisstemplate, choose Tools | Templates
. . .
. E TestF‘an:kages ﬂand opeh the template in the esditor.
-8 Libraries Pestafas de archivos
- Test Libraries i
@ package trigonometriar ablertns
Explorador de
archivos Ventana de edicion
* @author kobkol
lic class Main |
@param args the comnand line arguments
: Navigator 4 x iz static wvoid mair(3tring[] args) |
- ToDD code application logic here
Members Yiew "W
-6 Main
- @ main(tringl] args) Botones para mostrar u ocultar
' fragmentos de codigo
11 | INS |
Detalles sobre T
las clases G| Descripkion File o Lo
D Eﬁ}|,l',l' TODO code application logic here |Main.]'ava|18 |...sr
=) | |
= Area de mensajes
P
SR A — .
fe 08085 o= R T s
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® triconometria - NetBeans IDE 6.5.1

File Edit “iew Mavigate Source Refackor Run Debug  Profile  Wersioning Tools  Window  Help

E E@ '_'—l |-=:|:IeFau|I: config = v| Dﬂ“‘ Dﬁ . @ . E

-

: il = IEFiles Services | @ Main, java * x]
trigonometria = S i
S8 RE-H-ASFEFPLR S e H
= Source Packages
P : 1 package trigonometria;
= trigonometria 5
@ Main. java 3 i i e
L) Test Packages . pe et IR
#-I[8 Libraries . e . g o nd
tat T
E}-@ ot Lirauss jul ie static void main (3tring[] args) |
& aystemwm.out.println("+++++++t++tttbttt 4+
7 System.out.println(™ OEIERVATORIO CHNICE™):
g Gystem. cut.println("++++++++HHHHHHE T
8 '
10 3
|: Main - Mavigator il = 11
Mermbers Yiew o
= Main 31 |Ing |
“o - maingString[] args)  Dutput = x]g.Tasks

L5 | Debugger Console x| trigonometria (runy) = |

iir:um: )
%& ++++++++++++4++++HHHE
OBSERVATORIO CHICE
+++++++++++++++ S
BUILD STUCCESSFUL (total time: 0 seconds)

% (0885 =

Examinemos en detalle la carpeta de proyecto. Veras que se han creado multiples subcarpetas
en tu directorio de trabajo:
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trigonometria

—
ar

chivo  Edicion  Wer  Faworitos  Herramienkas  &wuda

e.ﬁ.trés - \_/I L@ fﬂ] Biisqueda ll. Carpetas =k x q *

Diregciénj_[ﬁ E:\MetBeansProjectsitrigonometria

o M T

' —’J dist J ABpraieet
1 1

=,
!

o _ * build, xml
e kesk ’ G | Documento 2ML
| =— | 4kBE

manifest.mf
archivo MF
1kKE

52 Mi equipcl
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W trigonometria - NetBeans IDE 6.5.1

File Edit

Wieww  Mavigate Source Refactor

Fun Debug Profile  Versioning Tools

Window  Help

Q-1

Y T W D E-B-

E % [@ _—l |{dEFauIt config

:Pro... 40 = |:Files |: Services

@CnlecciDnCuadradns.java xl@ Cuadrado.java = @

=

riangulo.java =

EIQ trigonometria

EB-8-ATFE PR o

I

@

Wz

=-[(f Source Packages

LD

@ base : double

|

E'EEl Fias 1 package Liguras;
> @ Circunferencia.java 2 ) i
>|§5| ColeccionCuadrados. java Z 1{::1:1::11:: cless ERTHEOEER
:% :::tl:ligaaj:.]ava 5 private double hase;
7 : =) private double altura:
|F_6| Triangulo,java
H-FH otropaguete 1 _ )
E}-% et P e o g public Triangulo (double base, double altura)
F-[8 Libraries : ¢ :
E}-@ Test Libraties 10 th}s Jase=hase:;
11 thiz.altura=altura;
12 b
13
14 public double getBase ()
15 i
1a T return base;
aaianaule s ioxioator B | public void setBase {(double base)
Members Yiew w 19 ;
=y Triangulo 20 T this.base=bhase;
- ¢ Triangulafdouble base, double alkura) 31 }
- calcularfrealy @ doubls 22 public double getAlturai)
- {0 calcularHipotenusal) @ double 23 g
- (0 calcularPerimetrol) @ double 24 T et Bt
- () getdltural) @ double 3K )
@ getBase(): double 26 public void setdltural()
- (3 imnprirnir) P !
- setélural) 511 | NS |
- () setBase(double base)
B alura : double : Dutput - trigonometria (run} ¥Fx ]I ‘Tasks
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W trigonometria - MetBeans IDE 6.5.1

File Edit “iew MNavigate Source FRefackor Run Debug  Profile  VMersioning Toaols  ‘Window  Help
ok D@ oo 9T W D B G- o
?E_I;ru... ;I]_:]Eﬁles ff.Serv.rices |F_E| ColeccionCuadrados. java xl@ Cuadrado.java = 1|r.Ei_Triaru;u.lh;.jewa"‘ x] |E:
i trigunometia B-0-QTHFEfPe G 00 &
Eib?j Source Packages _ - —— e
FER 1 package figuras:
g figuras .
@] Circunferencia, java . bl " Tri
: iz class Triangulo
>|§5| ColeccionCuadrados. java . ?
- [@ Cuadrado.java
% Tect i ; 5 private doukble hase:
est.java
i 3 ] : =] private double altura;
@ Triangulo.java
&8 otropaquete 7 cannat find syrmbal
g public Trialsymbol @ variable bse double altura)
#-IF Test Packages g { location: class Figuras. Triangulo
-8 Libraries
s this. e=hase;
-IL@ Test Libraries & ) EE“
11 thiz.altura=altura;
12 i
13
14 public double getBasel()
15 {
16 return hase:;
e | }
i aliaxiogtor =l - public void setBase (double hase)
Mernbers Yiew A 19 {
=iy Triangulo ‘&T this.bhase=bae;
-~ ¢ Triangulofdouble base, double alkura) 21 4
D calcular.ﬁ.rea{} : double 22 public double getAltural)
- (0 calolarHipotenusal) @ doubls 0 f
= i calcularPerimetro) © double QT b4 reurn altura:
~ @ getalkural) @ double 25 T A
(0 getBasel) : double 26 public void setAlturalf)
=y imprirnir) P ,
= (0 sethltural) 10:15 | NS |
- {3 setBase(double base) : - - ]
& alura : double : Dutput - trigonometria (run) ¥ x| Tasks
& base : double [
5 I*
.
B I (80 @ | 5.] =
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W NetBeans IDE 6.5.1

File Edit Miew Mavigate Source Refackor Run Debug  Praofile  Mersioning  Tools  Window  Help
']JF:] % — '—| |-::-:|eFauItl:-:unFig:=- v| E'Er Eﬁ |> @ - C|Q."
REEE - 1MS |
E-EHPI‘D... FI|E5 -f.EISE... 1l = ...avaI@] Cuadrado.java x]@] Triangula. java x]@Test.java x|
EI@ 'main’ at line Izl_reakpn:uint [ - - QR I5|||:|D| SR el @ O #: s
“[] Test.main:19 : ,,
10 cual. iwprimirc() ;
11
12 Circunferencia cirl=new Circunferencia(4.8);
13 cirl.imprimir () ;
14 cirl. imprimic3 ()
15 Circunferencia cirZ=new Circunferencia (1.5):
15 cirZ . imprimie()
17 cird . imprimirz ()
15
F=+ Triancgulo tril=new Triangulo [S5,15):;
20 tril.imprimic():
21
{— l l =] System. cut.println("Para calcular el Orea de ls
@%% E&%@l&g 23 System. cut.println("El Orea de la figura comple
24
-ETESt_NavigatDr dl = 25 double perimetroTotal=tril.calcularFerimetroi)
Members Yigw w 26 System. cut.println("El perOmetro de la figura ¢
=60 Test =t
(p mainistring[] args) 28 . System.out.lprintln(”El perOmetro del trifngulo
z2il | INS |
i.f Watches Local Yari.. ¥ xlgﬂreakpuints Output Taih
ENE Type Yalle
O static (]
@ args ] E] #49(length=0)
El@ cual 150ra E] #30
B4 dirl Feren [ #s1
@ radio & D hE
=4 dir2 Feren [] #s2
b EREE)=]| & " s
running. ..
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Al igual que con el resto de entornos, terminemos con una breve exposicion de sus aspectos
mas destacados:

Puntos fuertes de NetBeans

- Sin duda, el mas completo, estable y fiable de los tres

- Si un alumno necesita programar en su vida profesional y ha aprendido con NetBeans,
podra enfrentarse con confianza a cualquier entorno presente en la empresa, ya que todos son
muy parecidos entre si

- La gestién de paquetes y sus avanzadas detecciones de errores (incluso antes de
compilar) resultan mas cOmodas e intuitivas que en los otros entornos

Puntos débiles de NetBeans

- Su consumo de recursos es significativamente mayor que el de las otras alternativas

- Enfrentarse a un entorno algo complejo como NetBeans puede desanimar o confundir al
alumno, especialmente si no tiene nociones de programacién

- Sus multiples ayudas al programador pueden no ser adecuadas para iniciarse en el
lenguaje Java

Conclusiones

Seguramente a estas alturas ya te hayas hecho una idea de qué entorno te interesa mas; pero
por si acaso, hagamos un repaso final.

- Blued es un entorno visualmente agradable, sencillo, y con potentes afiadidos para
facilitar la tarea docente; pero el trabajo intensivo resulta mas incbmodo y en su busqueda de
simplicidad elude algunos aspectos del lenguaje Java.

- jGrasp es algo menos atractivo y, si bien ofrece también las algunas facilidades
interactivas, no quedan tan bien integradas como en Blued. Sin embargo, su organizacién de
archivos es mucho mas clara, y su uso prepara mejor al alumno para el uso de entornos
profesionales.

- Uno de esos entornos profesionales es NetBeans: todas las funciones avanzadas estan
presentes en este potente IDE, con la ventaja adicional que ofrece su sencilla instalacion junto
con el kit de desarrollo. No obstante, utilizar un entorno tan potente para iniciarse quiza sea
excesivo y desde luego no es buena idea si se dispone de equipos con caracteristicas mas
bien modestas.
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La siguiente tabla recoge esquematicamente algunas de las diferencias entre los entornos
estudiados:

|Caracteristica | | BluedJ | |jGrasp | |NetBeans
Version del entorno en castellano | |No | |Algunas versiones |
|Existencia de documentadidionéitialierocastellano No | |No |
Disponibilidad en Linux| |Si | |Si REl |
Tipo de licencia | |GNU (software libre) | | Propietaria (freeware) | CDDL y GPL2 (software |
| Permite trabajar con otrodNlenguajes de programacgin | Si |
| Generacion automatica d8idocumentacion (JavaD@&i) | Si |
Informacion esquematicaEstasdas clases | | Completa (diagrama UMLAbundante |
|Gestion de paquetes | |Confusa | |Regular | |Buena |
| Funciones de depuracionMuy basicas | | Basicas | | Avanzadas |
| Funcionalidades avanzadile (refactorizacion, contrdlae versiones...) | Si |
|Creacion y manejo de objeliog féisilalmente sin progdtaaila principal | |No |
| Espacio aproximado en discd/@uro |6 MB | |160 MB |
| Consumo aproximado de#fdvtdria (10 clases abieBadvB el editor) | 140 MB |
Fiabilidad para uso intengi@ en proyectos semi o Mofesionales | Si |
| Comodidad para trabajar Bajamultiples archivos abitios | |Alta |
'Complejidad de uso | |Muy baja | |Baja | |Media |

Ten muy presente que la facilidad de uso de un programa no puede expresarse en una tabla.
Si tienes dudas, lo mejor es instalarlos y hacer unas cuantas pruebas: al final todo es cuestion
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de gustos, y deberias escoger aquel entorno con el que sientas mas seguridad y confianza.
¢,Aun no lo tienes claro? Un ultimo criterio: piensa en el motivo por el que tus alumnos
aprenderan Java. Si es una mera iniciacién a la programacién pero no es probable que vayan a
programar habitualmente en un futuro proximo, escoge Blued; pero si estas preparando a tus
alumnos para ser programadores, utiliza NetBeans. Si te encuentras en una situacion
intermedia, puedes apostar por JGrasp. Cualquiera que sea el entorno elegido, la ensefianza
de Java resultara una experiencia estimulante y creativa: y no sélo para los alumnos, sino
también para el profesor.
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